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Introduction

Ansys, Inc. uses the FlexNet license manager for all its licensed products. This guide provides you with
the instructions necessary to configure the client-side license manager settings.

Supported Hardware Platforms
« Linux x64 (linx64)
* Windows x64 (winx64)

For specific operating system requirements, refer to the installation guide for the platform you are
running. For platform support information, see the Platform Support section of the Ansys Website.

Summary of New and Changed Features

Listed below is a summary of those licensing items that are either new or have been changed since the
last release. For a list of all major new and changed features of any product, see the Release Notes
document for that product.

Desktop:
+ The Ansys License Manager has been updated to FlexNet Publisher client version 11.19.9.0.
+ The Ansys License Manager has been updated to OpenSSL version: 3.5.4.
+ The Ansys License Manager has been updated to Java version: 21.0.8.9.
+ The Ansys License Manager has been updated to Tomcat version: 10.1.48.
+ The Ansys License Manager has been updated to Curlt version: 8.16.0.
+ Added support for IPv6 to Elastic Licensing.
* General security and performance improvements.
« The ANSYSLI_ prefix has been changed toANSYS_LICENSING_.
+ Ul Changes:
- The left-hand menu has been restructured.

— A single location to opt in or out of Ansys Product Improvement Program (APIP) for all applic-
ations.

- A Windows-specific proxy option removed on Linux.

1.Understanding Ansys Common Licensing

Ansys Common Licensing (ACL) creates direct communication from all Ansys applications to the FlexNet
Publisher server. ACL is launched when an application makes its first licensing call and continues to run
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until all connected clients exit. By default, ACL uses a random port to listen to all clients. ACL can be
configured to use ports from user specified range. To configure ACL to use a specific port, see Specifying
a Desktop Port Range (p. vii).

There is one ACL per process tree, meaning the parent and all the children connect to the same ACL
launched by the parent.

1.1.License Sharing with Ansys Common Licensing

By default, licenses are shared in a parent/child process tree. Ansys Common Licensing follows par-
ent/child/max logic. Here are a few examples of this logic:

« If the parent checks out the increment "meba" and the child tries to check out the same increment
"meba" then the net result is there is only one increment "meba" consumed from the license serv-
er/pool.

+ If the parent checks out increment "meba" and the child tries to check out the 2 counts of the
same increment "meba" then the net result is there are two tasks of "meba" consumed from the
license server/pool. This is an example of max logic

+ If the parent checks out 1 count of the increment "meba" N number of times, then the net result
is there is only increment "meba" consumed from the licensing server/pool.

Parent/Child across machines/process tree: This process enables the parent child sharing for the
specified license features with child being on a different machine.

User Host Display: This process enables applications to share the same listed features across multiple
instance of the applications for a specific user tied to the host/display.

HPC Parametric Sharing: HPC parametric sharing enables applications to use a single solver license
and anshpc_pack or 8 anshpc features for each additional variance. This also allows applications to
share anshpc_pack increments for core checkouts from the solves started as variances of the same
context. For more information on HPC Licensing, see HPC Licensing (p. 37).

Note:

Queuing is not supported in any type of license sharing.

1.2. Ansys Common Licensing Environment Variables

This section describes Ansys Common Licensing-related environment variables and their usage.
1.2.1. Specifying a Desktop Port Range
1.2.2.Restricting Connections to the Loopback IP Address

Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
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Licensing Prerequisites for Running Ansys Products

1.2.1.Specifying a Desktop Port Range

You can use the ANSYS_LICENSING_DESKTOP_PORT_RANGE keyword to configure Ansys Common
Licensing to communicate using a specific port or port range. This keyword can be added as an
ansysimd.ini file entry or as environment variable.

Note:

If ACL can not use a port from the provided range, it will connect through a free
port assigned by the operating system.

Format:

ANSYS_LICENSING_DESKTOP_PORT_RANGE=<Min Range:Max Range>
Example:

The following example causes ACL to use a port in the range of 5000 to 5100.

ANSYS_LICENSING_DESKTOP_PORT_RANGE=5000:5100

1.2.2. Restricting Connections to the Loopback IP Address

Setting the ANSYS_LICENSING_ACL_BIND_TO_LOOPBACK environment variable will restrict Ansys
Common Licensing to only accept connections made to the loopback IP address (127.0.0.1). This

will restrict access to only those applications running on the local machine on which ACL is running.
While this enhances local isolation, it also prevents context sharing across machines which may
impact workflows that rely on distributed communication.

Format:

ANSYS_LICENSING_ACL_BIND_TO_LOOPBACK=1

Note:

When using Ansys products prior to release 2025 R2 (2025 R1 or earlier) use ANSY-
SCL_BIND_TO_LOOPBACK=1.

2. Licensing Prerequisites for Running Ansys Products

When running Ansys Products Release 2025 R1 or newer, your license server must be using a minimum
of Ansys License Manager Release 2024 R1.03. Additionally, the client systems must be pointing to the
license server, using an FlexNet Publisher binaries equal to or greater than v11.19.5.0 on the license
server.

Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates. vii



Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
viii of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.



Chapter 1: Ansys Licensing Settings Utility

This chapter explains how to use the Licensing Settings utility to configure connections with both
FlexNet Publisher and Elastic Licensing servers. The Licensing Settings utility is installed automatically
when the product is installed; you do not have to take any further steps to run as a client if you have
installed a product.

1.1.Understanding the ansysimd.ini File

A number of the options in the Ansys Licensing Settings utility modify the ansyslImd. ini file that
is located in the licensing directory. Because of this, it is generally a good idea to have an understanding
of the contents and purpose of the file. Entries in the ansyslImd. ini file tell Ansys, Inc. products
which license server(s) to query to find a valid license. Using this option allows all users at your site to
use this setting without having to individually set the ANSYSLMD_LICENSE_FILE environment variable
to specify the license server machine(s). It also eliminates the need to have a copy of the license file on
every system at your site. Additionally, if you are using Ansys Elastic Licensing, the ansyslImd. ini

file contains your Cloud License Server ID (CLSID) and pin (CLSPIN).

1.1.1.ansysl nd. i ni Server Entries

The order that the SERVER lines are listed in the ansyslImd. ini file dictates the order in which the
license servers are queried when attempting to check out a license.

You are not limited to designating one set of license server machines for your network. You can have
multiple single-server or three-server (redundant triad) licensing systems on your network. In this
situation, you would have certain licenses connected to a set of server machines (one or three) on
the network, and other licenses connected to a different set of server machines (one or three) on the
network.

Each server's specification entry in this file will typically begin with SERVER= to specify the server port
numbers.

On a single server:

SERVER=<f | exnet por t >@<host >

For multiple single servers, each server should have its own SERVER= lines.

On redundant (triad) servers on Linux platforms:

SERVER=<f | exnet port >@<host 1>:<f | exnet por t >@<host 2>:<f | exnet port >@<host 3>

Windows platforms use semicolons (;) instead of colons:

SERVER=<f | exnet port >@<host 1>;<f | exnet por t >@<host 2>;<f | exnet port >@<host 3>
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Ansys Licensing Settings Utility

Do not use commas as separators; use colons (:) on Linux machines and semicolons (;) on Windows
machines.

You must use the port@host format; you cannot enter a path or a filename in place of the hostname.

Modifying the Server Order:

You can use the ANSYSLMD_LICENSE_FILE environment variable to supersede the existing server
configuration. The servers that are defined in the ANSYSLMD_LICENSE_FILE environment are added
to the beginning of the server path.

For example, if your ansysimd.ini file contains the line SERVER=server1;server2 and and your AN-
SYSLMD_LICENSE_FILE environment variable contain server3 and server4, your server path will be
server3, server4, serverl, server2.

If you set the ANSYSLMD_LICENSE_FILE environment variable on a three-server (redundant) system,
specify all three systems in the same order as the SERVER lines are listed in the license file. If you
specify only the master and it is down, you could see a "License Server Down" or "No License Found"
message and the search for a license could fail. Join redundant or multiple single server systems by
separating the system names with colons on Linux systems and semicolons on Windows systems.

1.1.2.ansysl nd. i ni Elastic Licensing Entries

The ANSYS_ELASTIC_CLS entry contains your computer's CLSID and CLSPIN. This entry is appended
to your ansyslmd. ini file when you add or update them by using the options in the Ansys Licens-
ing Settings utility. For more information, see Changing the Elastic Licensing PIN .

ANSYS_ELASTIC_CLS=<CLSI D>:<CLSPI N>

Alternatively, if you are comfortable modifying the text in the ansyslImd. ini, you can enter the
CLSID and CLSPIN manually.

1.2.Using the Ansys Licensing Settings Utility

To run Licensing Settings utility on Windows, choose Start> Ansys 2026 R1> Ansys Licensing Settings
2026 R1.

To run the utility on Linux, type the following:

/ansys_inc/v261/licensingclient/linx64/LicensingSettings

Important:

On Linux systems, Ansys Licensing operates within the context of the "DISPLAY" being used.
If you are using multiple virtual desktops, the information shown by the Ansys Licensing
Settings utility (LicensingSettings executable) is limited to that of the DISPLAY on which Li-
censing Settings is being run.

For example, if you are running an Ansys simulation application with Web Licensing in one
virtual desktop and Ansys Licensing Settings in a different virtual desktop, the license(s) in
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Using the Ansys Licensing Settings Utility

use by the simulation application will not be shown in Licensing Settings' Web Licensing
> Products table. Similarly, the command 'LicensingSettings web products in-use' will not
list the simulation license in use when the command shell window is in a different virtual
desktop.

To see in-use Web licenses in the Ansys Licensing Settings application, start it within the
same virtual desktop as the running simulation application(s).

To list in-use Web licenses by the 'LicensingSettings web products in-use' command, start

the command shell window within the same virtual desktop as the running simulation ap-
plication(s). Alternatively, some Ansys applications provide a way to issue operating system
commands from within them. For example, entering "! /ansys_inc/v251/licensingclient/linx64/Li-
censingSettings web products in-use" within Fluent's Console window will produce the ex-
pected results. Consult the documentation for specific Ansys applications for information

about issuing operating system commands from within them.

Understanding the Ansys Licensing Settings Utility User Mode

The Ansys Licensing Settings utility contains an option to allow you to customize your settings to suit
your individual needs. In the upper right-hand corner of the Ansys Licensing Settings utility interface
is a dropdown menu with the options Installation and User.

When this menu is set to Installation, the Ansys Licensing Settings utility uses the global settings that
were defined during installation.

When set to User, the Ansys Licensing Settings utility uses the user-specific settings that have been
defined and saved for an individual user. The user-specified settings are stored in a new user-specific
ansysimd.ini file created in one of the following locations:

+ Windows: %AppData%\.ansys_licensing\ansysimd.ini

+ Linux: ${HOME}/.ansys_licensing/ansysimd.ini

Ansys Common Licensing (ACL) gets a value for a given setting in this order:

1.

2.

ACL starts by attempting to retrieve the value from an environment variable.

If ACL does not find the value in an environment variable, it attempts to retrieve the value from the
settings in the new user-specific ansysimd.ini file.

If ACL does not find the value in the user-specific ansysimd.ini file, it defaults to the value in the
global installation settings.

Caution:

When switching from the Installation to the User option, the utility-wide default settings

are displayed but are not active until you have selected, changed, and saved each of them.
Until settings are individually selected and saved, the global settings that were defined during
installation are used. Each setting is independent of all other settings and must be configured
and saved individually. For example, after switching to User mode, the FlexNet Publisher Li-
cense Servers option is displayed as disabled (not enabled) but this setting is not truly set
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Ansys Licensing Settings Utility

until you either switch the option to Enabled and Save (to enable the setting) or switch the
option to Enabled then back to Disabled and then Save (to disable the setting).

Refer to the links below for instructions on using the list of options in the utility.
1.2.1. Defining FlexNet Publisher License Servers
1.2.2.Operations on Shared Web Licenses
1.2.3.Setting License Service Priority
1.2.4.Enabling the Ansys Product Improvement Program (APIP)
1.2.5.Configuring a Proxy Server
1.2.6. Gathering Diagnostics

Command Line Interface Options

Log in to and out of your Ansys ID account:

LicensingSettings account login

LicensingSettings account logout

Options:

--help Show help [boolean]

--token Token file or string [string]

--input Login with the token file generated on the AnsysID portal

Examples:

LicensingSettings account login --input "path/to/file.json”
Login using a token from a file.

LicensingSettings account login --token "TOKEN STRING"
Login using a token string.

LicensingSettings account login

Log into your Ansys ID account. If already logged in, show logged-in user details.
LicensingSettings account logout

Log out of the currently signed in account.

1.2.1. Defining FlexNet Publisher License Servers

You are asked to specify your license server during the product installation if you have not done so
during a previous product installation. If you did not specify your license server during the product
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Using the Ansys Licensing Settings Utility

installation, or if your license server has changed, use the FlexNet Publisher > License Servers option
to define the FlexNet Publisher server, default communications port and usage order.

This information is stored in the ansyslmd.ini file. The information contained in this ansysimd.ini file
is used by globally by all users.

+ To enable FlexNet publisher, toggle the Enabled option.

+ To add license servers, click the "plus" icon (located below the existing servers) and enter the
communications port and server hostname(s) then click Test to verify the configuration. If the
server is available, a green check mark is displayed to the right of the server information. Click Save
to complete this process.

Note:

To specify redundant triad servers, enter the hostname for each of the three servers in
the spaces available.

+ To remove a license server, click the "minus" icon to the left of the appropriate server and then
click Save to complete this process.

+ To adjust the order of the servers in your list, click and hold the "double arrow" icon to the left of
the appropriate server and drag the selection to the new postion within your list. Click Save to
complete this process. The order of the servers dictates the order in which they are queried when
attempting to check out a license.

Note:

Unresponsive servers can slow the license check-out process. If a license server is likely to
be offline or otherwise unresponsive for an extended time, consider removing it from the
list.

Command Line Interface Options
Enable FlexNet Publisher:
LicensingSettings fnp enable
Options:

--help Show help [boolean]

Mode:

description: 'Specify the LSU mode'
choices: ['user", "installation"]

type: "string"

required: true
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Ansys Licensing Settings Utility

Example:

LicensingSettings fnp enable --mode user

Disable FlexNet Publisher:

LicensingSettings fnp disable

Options:

--help Show help [boolean]

Mode:

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Example:

LicensingSettings fnp disable --mode user

Add FlexNet Publisher license server(s) to an existing configuration:
LicensingSettings fnp server add

Options:

--help Show help [boolean]

--input Add FlexNet Publisher license server(s) to existing configuration [required]
Mode:

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Examples:

LicensingSettings fnp server add --input 1055@serverl --mode user

Adds 1055@server1 to the end of the servers list.

LicensingSettings fnp server add --input 1055@serverl,l1055@server2 --
mode installation

Adds 1055@server1 and 1055@server2 to the end of the servers list.

Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
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Using the Ansys Licensing Settings Utility

LicensingSettings fnp server add --input 1055@serverl:server2:server3
--mode user

Adds the triad 1055@server1, 1055@server2, 1055@server3 to the end of the servers list.
Remove FlexNet Publisher license server(s) from an existing configuration:
LicensingSettings fnp server remove

Options:

--help Show help [boolean]

--input The server(s) to be removed from the configuration

--all Remove all the FlexNet Publisher license servers from existing configuration

Mode:

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Examples:

LicensingSettings fnp server remove --input 1055@serverl --mode user
Removes 1055@server1 from the configured server list.

LicensingSettings fnp server remove --input 1055@serverl,1055@server2
--mode user

Removes 1055@server1 and 1055@server2 from the configured server list.

LicensingSettings fnp server remove --input 1055@serverl:1055@serv-
er2:1055@server3 --mode user

Removes the triad 1055@server1, 1055@server2, 1055@server3 from the configured server list.
LicensingSettings fnp server remove --all

Removes all servers from the list.

List configured FlexNet Publisher license server(s):

LicensingSettings fnp server list

Options:

--help Show help [boolean]
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Ansys Licensing Settings Utility

Set FlexNet Publisher license server(s), removing the previous configuration:
LicensingSettings fnp server set

Options:

--help Show help [boolean]

--input Set FlexNet Publisher license server(s), removing any previous configuration [string] [required]
Mode:

description: 'Specify the LSU mode'

choices: ['user", "installation"]

type: "string"

required: true

Examples:

LicensingSettings fnp server set --input 1055@serverl --mode user

Sets 1055@server1 as license server.

LicensingSettings fnp server set --input 1055@serverl,l1055@server2 --
mode iInstallation

Sets 1055@server1 and 1055@server2 as license servers.

LicensingSettings fnp server set --input 1055@serverl:server2:server3
--mode user

Sets the triad of 1055@server1, 1055@server2, 1055@server3 as license server.

1.2.1.1. Defining FlexNet Publisher User-Specific License Servers

In cases where you require user-specific license server, you can create a new user-specific ansysimd.ini
file that supports this information. To do this:

1. Open the Ansys Licensing Settings utility and select the License Servers option.
2. Set the dropdown menu, located in the upper right-hand corner of the display to User.

3. Click the "plus" icon (located below the existing servers) and enter the communications port
and server hostname(s) then click Test to verify the configuration. If the server is available, a
green check mark is displayed to the right of the server information.

4. Click Save to complete this process.
A new user-specific ansysimd.ini file is created in the following location:

+ Windows: %AppData%\.ansys_licensing\ansysimd.ini
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Linux: ${HOME}/.ansys_licensing/ansysimd.ini

When using the FNP server path settings - if using ANSYSLMD_LICENSE_FILE as env then one of
the ini settings are also considered, either the user ini or the global ini.

1.2.1.2. Displaying Features Usage

Click the FlexNet Publisher > Features in Use option to display all features that are currently being
used. This option displays:

The license server name
Current license file in use
Available license features
Available licenses per feature

Licenses used per feature

Command Line Interface Options

Get license feature status:

LicensingSettings fnp server in-use

Options:

--help Show help [boolean]

1.2.1.3. Borrowing Licensing Increments

Click the FlexNet Publisher > Borrowing option to display a drop-down menu containing a list
of borrowable licensing increments (available only on Windows machines). License borrowing allows
you to take a license for use while not connected to the network.

Note:

This feature is available after defining a FlexNet server.

To borrow license increments:

1.

From the Borrowing page, select the license increments you wish to borrow from the Borrow-
able Increments drop-down menu.

Set the return date for each increment.
When you have finished selecting your increments and setting the dates for each, click Borrow.

When you are finished with the license increments, return to the Borrowing page and click
Return for the appropriate increment or Return All to return all increments.

Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates. 17



Ansys Licensing Settings Utility

Command Line Interface Options

Borrow a License Increment from the License Server List:
LicensingSettings fnp borrow checkout
Options:

--help Show help [boolean]

--input Specify the increments to borrow from license server [required]
--expiry Expiration/return date [required]

Mode

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Example:

LicensingSettings fnp borrow checkout --input
"cfd_solve levell”,"cfd_solve level2" --expiry 2022-10-03 --mode user

Borrows the increments "cfd_solve_level1" and "cfd_solve_level2" from license the server.
Return a license increment from the license server list:

LicensingSettings fnp borrow checkin

Options:

--help Show help [boolean]

--input Specify the borrowed increments to return to license server

--all Return all borrowed increments to license server

Example:

LicensingSettings fnp borrow checkin --input
"cfd_solve_levell”,"cfd_solve_level2"

Returns "cfd_solve_level1" and "cfd_solve_level2" to license the server.
Get a list of currently borrowed increments:
LicensingSettings fnp borrow in-use

Options:
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--help Show help [boolean]

List increments available for borrowing:
LicensingSettings fnp borrow list
Options:

--help Show help [boolean]

1.2.2. Operations on Shared Web Licenses

Click the Web Licensing > Shared option to display a list of Shared Web product licenses. Products
are displayed along with the related "customers" (accountid). Multiple products with the same name,
but with different customers, can be displayed.

License roaming allows you to take a license for use while not connected to the network. It is similar
to Borrowing with FlexNet Publisher licenses.

To roam with Shared Web product licenses:
1. From the Shared page, select the Roaming option.

2. A list of available Shared Web product licenses is displayed. Click the Check Out button for the
appropriate product.

3. A dialog box is displayed, allowing you to select the number of product licenses you require and
the return date for the licenses.

4. When you have selected the number of licenses and the return date, click Check Out.
5. Perform the above steps for all Shared Web product licenses you wish to roam with.

6. When you are finished with the licenses, return to the Shared page and click Return for the ap-
propriate licenses or Return All to return all licenses.

JSON File Property Specifications
accountld: The customer account to which this product is entitled.
available: The quantity of this product available to be checked out for the logged in Ansys ID account.

id: A unique identifier for a particular license entitlement. Can be used to checkout or checkin a
specific product from a specific customer account.

name: Product name
partNumber: Product SKU
total: The maximum quantity potentially available for the logged in Ansys ID account.

version: The maximum version of client software this product license supports.
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Command Line Interface Options

Enable Shared Web licensing:

LicensingSettings web shared enable

Options:

--help Show help [boolean]

Disable Shared Web licensing:

LicensingSettings web shared disable

Options:

--help Show help [boolean]

Roaming with a Shared Web Licenses:

LicensingSettings web shared products checkout
Options:

--help Show help [boolean]

--input Check out products specified in file

--name Name of the product to checkout

--count Count of the product to checkout, mandatory for each product name
--expires Expiry of the products in ISO8601 format date or duration [string]
Examples:

LicensingSettings web shared products checkout --name "Example Name 1"
-—count 234 --name "Example Name 2" --count 24 --expires "P3DT4H59M™"

Checkout products using the CLI.

LicensingSettings web shared products checkout --input "path/to/in-
put/file._json”

Checkout products listed in a file.

The file should be a valid of valid JSON structure with following format:

{
"products™: [

{
"name": "Example Name',
count': 23

X

{
"partNumber™: "PARTNUMBER",
“‘count': 343

X,

20
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{
“id": "ID",
“count': 23
¥
1.
"expires': "1S08601 format date or duration®

}

The 'expires' field is optional; if not specified, existing checkout date will be used, in absence of which
the default duration from the server will be used.

If multiple 'expires’ are specified, the last one will be used for the checkout.
Return a Shared Web License:

LicensingSettings web shared products checkin

Options:

--help Show help [boolean]

--input Check in products specified in file

--all Check in all products of specified type

--name Check in products by name

--type Specify the type of products to checkin [choices: "roaming", "on-demand"]
Mode

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Example:

LicensingSettings web shared products checkin --name "Example Name 1"
-—-name "Example Name 2" --type roaming

Check in some products of type 'roaming'.

LicensingSettings web products checkin --name "Example Name 1' --name
"Example Name 2" --type roaming --licenseModel "Named User' --mode user

Check in all roaming products.
LicensingSettings web products checkin --all --type roaming --mode user

Check in all on-demand products.
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LicensingSettings web products checkin --type on-demand --all --mode
user

Check in products specified in input file, of type roaming.

The file should be a valid of valid JSON structure with following format:

{
“products™: [
{
“name': "Example Name"
E
{
“partNumber': "PARTNUMBER"
E
{
“id": "ID
}
]
}

Note that the file used for checkout can also be used here, but 'count' will not be honored.
Get a List of Shared Web Licenses:

LicensingSettings web shared products in-use

Options:

--help Show help [boolean]

--type Product usage type [string] [required] [choices: "roaming", "on-demand", "all"] [default: "all"]
List Shared Web Licenses Available:

LicensingSettings web shared products list

Options:

--help Show help [boolean]

--output Get products list in the specified file [required]

Example:

The output would have product information in JSON structure with following format:

{
"1d": "Unique identifier for this license asset",
"partNumber™: "Product SKU",
"accountld”: "Customer account this product is entitled to",
“name': "Product name",
"version': "Maximum version of client software this product license supports",
"available™: "Quantity of this product available to be checked out for the logged in Ansys ID account",
"total': ""Maximum quantity potentially available for the logged in Ansys ID account"
ks
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1.2.2.1.Enabling Elastic Licensing

Click the Elastic Licensing option to enable elastic licensing and import your Elastic License Server
and Elastic License Server PIN.

To enable elastic licensing:
1. Toggle the Enabled option.

2. Click Import CLS ID and CLS Pin and browse to the directory containing json file supplied by
your elastic licensing administrator.

3. Select the file and click Open.
4. Click Save.
This information is saved to your ansyslImd. ini file.
To disable elastic licensing:
1. Toggle the Enabled option.
2. Click Save.
To import new elastic server information:

If license administrator changes the PIN for the Elastic License Server, client-side users should perform
the following steps.

1. From the Elastic page, click the Import CLS ID and CLS Pin button.

2. Browse to the directory containing json file supplied by your elastic licensing administrator.
3. Select the file and click Open.

4. Click Save.

Your ansysImd. ini file is updated, and the ID and PIN are displayed in the Ansys Licensing
Settings utility.

Command Line Interface Options

Enable Elastic Licensing:

LicensingSettings web elastic enable
Options:

--help Show help [boolean]

Mode

description: 'Specify the LSU mode'

choices: ["user", "installation"]
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type: "string"

required: true

Disable Elastic Licensing:

LicensingSettings web elastic disable
Options:

--help Show help [boolean]

Mode

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Print Elastic Licensing Settings:
LicensingSettings web elastic list
The output can be passed into the 'set' command.
Options:

--help Show help [boolean]

Mode

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Example:

LicensingSettings web elastic list > tmp.json --mode user
Configuring Elastic Licensing Settings:
LicensingSettings web elastic set
Configure Elastic Licensing settings via specified input file.
Options:

--help Show help [boolean]
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Example:

LicensingSettings web elastic set --input tmp.json

1.2.3.Setting License Service Priority

Click the Preferences > License service priority option to display the order in which the licenses
are utilized.

+ To change the license service priority, click and hold the "double arrow" icon to the left of the ap-
propriate license service and drag the selection to the new position within your list. Elastic web
is always last and cannot be moved. After you have modified your list, click Save to retain your
changes.

Command Line Interface Options

View the Current Priority of Licensing Services:
LicensingSettings preferences service list
Options:

--help Show help [boolean]

Set the Licensing Service Priority:
LicensingSettings preferences service set
Options:

--help Show help [boolean]

--input Set order of licensing services [choices: "FlexNet Publisher","Shared web","Elastic web"] [required]
Mode

description: 'Specify the LSU mode'

choices: ["user", "installation"]

type: "string"

required: true

Examples:

LicensingSettings preferences service set --input "Shared web™","FlexNet
Publisher™," " Elastic web"™ --mode user

Set the order of licensing services.
Resetting Licensing Service Priority:

LicensingSettings preferences service reset
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Options:

--help Show help [boolean]

1.2.3.1.Setting HPC User Preferences

Click the Preferences > HPC priority option to display the HPC products that are available and
the order in which HPC licenses are checked-out.

+ To change the license priority, click and hold the "double arrow" icon to the left of the appropriate
license and drag the selection to the new position within your list. After you have modified your
list, click Save to retain your changes.

+ To disable an HPC license, disable the check box to the left of the appropriate license and then
click Save.

Command Line Interface Options

Enable an HPC License:

LicensingSettings preferences hpc enable
Options:

--help Show help [boolean]

--input HPC preference to enable [choices: Ansys HPC Pack,Ansys HPC,Ansys Discovery Ultimate
Enterprise CPU Core Extension] [required]

Example:

LicensingSettings preferences hpc enable --input "Ansys HPC"
Enables “Ansys HPC"

Disable an HPC Licensing:

LicensingSettings preferences hpc disable

Options:

--help Show help [boolean]

--input HPC preference to disable [choices: Ansys HPC Pack,Ansys HPC,Ansys Discovery Ultimate
Enterprise CPU Core Extension] [required]

Example:
LicensingSettings preferences hpc disable —--input "Ansys HPC"
Disables “Ansys HPC”

List HPC License Priority:
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LicensingSettings preferences hpc list
Options:

--help Show help [boolean]

Set the HPC License Priority:
LicensingSettings preferences hpc set
Options:

--help Show help [boolean]

--input HPC preference to enable [choices: Ansys HPC Pack,Ansys HPC,Ansys Discovery Ultimate
Enterprise CPU Core Extension] [required]

Example:

LicensingSettings preferences hpc set --input "Ansys HPC","Ansys HPC
Pack',"Ansys Discovery Ultimate Enterprise CPU Core Extension"

Reset HPC License Priority:

LicensingSettings preferences hpc reset
Resets the HPC preferences to default state and order.
Options:

--help Show help [boolean]

Example:

LicensingSettings web elastic set --input tmp.json

1.2.4. Enabling the Ansys Product Improvement Program (APIP)

The Ansys Product Improvement Program (APIP) collects anonymous usage information about how
Ansys products are used, without affecting your work. By participating in APIP, you help to improve
the quality of Ansys products. APIP data collection is enabled by default. To opt-out, disable the setting
above.

Data collection includes computer hardware capabilities, operating system version, Ansys software
features used, total calculation time, and more. Ansys never collects information that could identify
a specific person, computer, location, company or other organization, nor does Ansys collect confid-
ential customer information such as specific geometry or other design inputs. For more information,
see the Ansys Global Privacy Notice (https://www.ansys.com/privacy).

Click the APIP option to display the Ansys Product Improvement Program configuration window. The
Ansys Product Improvement Program is enabled by default and can be disabled by modifying the
Enabled setting at the top of the page and clicking Save.
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Command Line Interface Options
Enabling APIP:

licensingsettings apip enable
Options:

--help Show help [boolean]

Disabling APIP:

licensingsettings apip disable
Options:

--help Show help [boolean]

View the status of the APIP setting:
licensingsettings apip list
Options:

--help Show help [boolean]

1.2.5. Configuring a Proxy Server
Click the Web Licensing > Proxy option to display the proxy server configuration window.

To use the local machine proxy settings on the Windows platform, enable the Use machine proxy
settings (Windows only) option.

To specify a proxy server, enable the Use specified proxy server option and the enter the Proxy
Server Address, Username and Password for the server.

Command Line Interface Options
Displaying current proxy settings:
LicensingSettings web proxy list
Options:

--help Show help [boolean]

Define Proxy Settings:
LicensingSettings web proxy set
Options:

--help Show help [boolean]

Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
28 of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates.



Using the Ansys Licensing Settings Utility

--server Proxy server to be set (Example: https://localhost:8080). Use 'windows' to use Windows proxy
settings. [required]

Examples:

LicensingSettings web proxy set --server windows

Set windows proxy as proxy server.

LicensingSettings web proxy set --server "http://<proxyserver>:<port>"
Set a proxy server via a URL (no authentication).

LicensingSettings web proxy set --server "http://<username>:<pass-
word>@<proxyserver>:<port>"

Set a proxy server via a URL (with authentication).
Test Proxy Settings:

LicensingSettings web proxy test
Options:

--help Show help [boolean]

--server Proxy server to test (Example: https://localhost:8080). Use 'windows' to test Windows proxy
settings. [string] [required]

Examples:

LicensingSettings web proxy test --server windows

Test the windows proxy.

LicensingSettings web proxy test --server "http://<proxyserver>:<port>"
Test a proxy server via a URL (no authentication).

LicensingSettings web proxy test --server "http://<username>:<pass-
word>@<proxyserver>:<port>"

Test a proxy server via a URL (with authentication.)
Remove Proxy Settings:

LicensingSettings web proxy remove
Options:

--help Show help [boolean]
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1.2.6. Gathering Diagnostics

Clicking the Diagnostics option and then clicking Generate gathers various licensing-related files,
logs and related information about your license client system and places them in a single directory
as well as a compressed file. This feature is useful if you want to easily review the files from a single
location, or if you need to send them to a technical support representative.

Command Line Interface Options
Gather Diagnostics:
LicensingSettings diagnostics
Options:

--version Show version

--help Show help [boolean]
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Chapter 2: End-User Configuration

This section contains licensing configuration instructions for Ansys Workbench and client environment
variable settings used to modify licensing behavior on indivdual machines.

2.1. Migrating Custom User Licensing Preferences

For Ansys Workbench users, customized user licensing preferences (if present), are automatically migrated
when you install a new Ansys release. For example, if you already have Ansys release 2025 R2 installed

on your computer and you upgrade to release 2026 R1, your customized user licensing preferences (if
present), are automatically migrated to the new version.

If you are using an Ansys product other than workbench, you can manually migrate your customized
user licensing preferences by running the ansysli_util.exe file.

To run the ansysli_util.exe, follow the steps for your platform below:
Windows:

Where <lInstallation Directory> represents the path to the latest Ansys Product install, open an admin-
istrator command prompt window and issue the following command:

"<Installation Directory>\<Version Number>\licensingclient\winx64\an-
sysli_util.exe" -updateuserprefs -fromrevn <previous release>

Example:

"C:\Program Files\ANSYS Inc\v261\licensingclient\winx64\ansysli_util._exe"
-updateuserprefs -fromrevn 261

Linux:

Where <lInstallation Directory> represents the path to the latest Ansys Product install, open a command
line window and issue the following command:

"<Installation Directory>/<Version Number>/licensingclient/linx64/an-
sysli_util" -updateuserprefs -fromrevn <previous release>

Example:
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""/ansys_inc/v261/licensingclient/linx64/ansysli_util" -updateuserprefs -
fromrevn 261

Note:

For both the automatic and the manual user licensing preferences migration, ansysli_util
reads the ansysimd.ini file or the ANSYSLMD_LICENSE_FILE environment variables to determine
the correct license server.

2.2. Ansys Workbench Licensing Methods

Ansys Workbench users can specify which of two licensing methods to use:

+ Share a single license between applications (shared mode). The Share a single license between
applications if possible is enabled by default in Ansys Workbench.

+ Use a separate license for each application (separate mode) by disabling the Share a single li-
cense between applications if possible option in Ansys Workbench.

Single License Sharing

Ansys Workbench allows you to work across multiple instances of the same applications while
consuming only one of a single type of license per user per session. Using shared licensing, the
active application holds the license, preventing other applications that are sharing that same license
increment/key from using it during that time. For example, trying to do multiple solves of same
type at the same time would be a concurrent event.

Sharing licenses is tied to the license keys the application is using. For example, if the application is
using license key "meba" then you cannot run other application instances or applications sharing the
license key "meba" at the same time.

Single license sharing allows you to progress through your analysis, from specifying engineering data
through building, setup, solving, and finally, reviewing your results, all under the same licenses. The
application holding the license must close or issue a PAUSE command or receive an automatic release
request to release the license and allow another application to use it. Licenses cannot be released while
an application is actively performing a concurrency event (for example, an application cannot release

a license in the middle of a solve operation because the license cannot be released until the solve op-
eration is completed).

Single license sharing applies only to licenses of the same type (for example, Ansys Mechanical Enterprise).
Choosing this option does not affect your ability to use licenses of different types simultaneously (for
example, Ansys Mechanical Enterprise for one task and ANSYS CFD for another).

Because this method is the default, you do not have to take any action to run this way.
Explanation of License Type and Examples

License type is primarily by license increment. It is possible to use different license increments

based on the operations performed within a single Ansys Workbench session. For example, Geometry
import, meshing and solving will checkout different license keys based on the capabilities the ap-
plication is requesting. For all applications, ANSYS licensing will first look at what other licenses
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are opened within this session: if any other licenses being used within this session fulfill the needed
capabilities Ansys licensing will share an existing license. If not, a new, different license is checked
out.

Restrictions for Single License Sharing:

You cannot run two concurrency events simultaneously (for example, you cannot solve two models of
the same type simultaneously) with one license.

If you are using a license for one application, other applications may still not be able to share that license
if those applications require capabilities not supported by the license. For example, you cannot share
a Mechanical Enterprise license with a Fluent application.

Single License Sharing in Ansys Workbench Applications
Ansys Workbench applications handle single license sharing differently:
Mechanical:

You can launch the Mechanical application and move between its components (such as Meshing, Setup,
and Solve). The active component will control the license while completing its operations and will release
the license as soon as the operation is completed. For example, when you mesh, the meshing component
will control the license during the meshing operation and then immediately release the license when

the operation is completed. During the meshing operation you cannot use the meshing increment in

any other systems under Ansys Workbench until the first system mesh is done and the license is released.
The other meshing component, if present in the subsequent systems, will go into read-only mode while
the first system mesh is still in progress.

Note:

Applications in read-only mode because of shared licensing do not refresh their license
status automatically. Once the shared license is released by the editor that had consumed
it, you must trigger Mechanical to query the license status. The most straightforward

way to do this is click outside the Mechanical application window and then click back

in the window to cause the license availability to be rechecked.

Mechanical APDL:

This application consumes a license as soon as you launch it and retains that license until it is finished.
If you launch the Mechanical APDL application interactively, the license is retained until you either close
the application or issue a PAUSE command at the Mechanical APDL command line. PAUSE allows you
to temporarily release the license for another application to use. No other operation other than SAVE
or EXIT is permitted while PAUSED. When the second application has finished and releases the license,
issue an UNPAUSE command from the Mechanical APDL command line to resume its use of the license.

CFX, Fluent, Autodyn, Polyflow:

These applications consume a license when launched and retain the license until they receive a request
from another application to release it. For example, when you open CFX-Pre, it will obtain and control
the license. It will retain the license until you close the application or until another application (such as
the CFX solver) requests it.
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Autodyn and Polyflow Classic also provide a manual PAUSE increment that allows you to interrupt
Autodyn or Polyflow Classic and release the license, temporarily, for another application to use.

Electronics:
Electronics applications do not support license sharing.
Separate Licenses

By using the separate-licenses method, Ansys Workbench requires a separate license for each ap-
plication. By using this method, you can move freely between the many applications that you

might require during an analysis in Ansys Workbench if you have sufficient licenses. You can leave
each application running and easily move between them at any point during the analysis, even if

one of the applications is actively using the license (such as during a solve process). The disadvantage
to this method is that you could potentially consume many licenses.

To activate the separate licenses method, open Ansys Workbench and click Tools>Options. From the
Project Management view, disable the Share a single license between applications if possible option.
After disabling this option, close options dialog box and restart Ansys Workbench.

Examples of Using Separate Licenses

You have two "ansys" increments. When you open and solve a model in the Mechanical application,
you consume one "ansys" increment. If you link that Mechanical analysis to a Mechanical APDL
system, you would consume a second "ansys" increment when you launch the Mechanical APDL
application, if you have not closed out of the Mechanical application. Neither of these licenses
would then be available for other users until you closed out of one or both applications.

2.3.Client Environment Variable Settings

You can set the following environment variables on individual machines to control their behavior, espe-
cially if you need it to be different from the general site configuration. These settings are especially
useful for situations where you are testing a new product installation/license manager installation on

a single machine before full site deployment, or other similar situations.

ANSYSLMD_LICENSE_FILE

Can be used to identify a license server machine or license file. If set, this specification is used
before any other license path information. The default port number assigned to Ansys, Inc. is
1055. Therefore, if your server has the hostname alphal and the IP address of 10.3.1.69, you
can identify the server to use as 1055@alphal or 1055@10.3.1.69.

ANS_FLEXLM_DISABLE_DEFLICPATH

Indicates that the default license path should not be searched when determining the licensing
path in the Ansys product. When this environment variable is set:

* Only ANSYSLMD_LICENSE_FILE environment variable setting is used.
* Only the ANSYSLMD_LICENSE_FILE environment variable setting is required.

+ Settings in the ansyslImd. ini file will NOT be used. It will ignore the local server and
will ignore the Specify the License Server setting.
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Client Environment Variable Settings

ANSYSLI_TIMEOUT_CONNECT

Used to specify the amount of time that elapses before the client times out if it cannot connect
to the server. Default is 20 seconds. Minimum timeout period you can specify is 5 seconds and
the maximum is 60 seconds. If the client determines that a server is not available in less time,

it will cancel immediately.

ANSYSLI_TIMEOUT_FLEXLM

Increases the amount of time ansyscl will wait for the FNP checkout from 5 (the default) to “N”
seconds.

ANSYSLI_TIMEOUT_TCP

Used to specify the amount of time that elapses before the client times out if it cannot get a
response from the server. This setting applies only when the license server is running but is
responding slowly (generally because of network issues or server load). Default is 60 seconds.
Minimum timeout period you can specify is 30 seconds and the maximum is 300 seconds.

2.3.1.1Pv6 Support

You can set the following environment variable to support the IPv6 protocol in the Licensing modules.
ANSYS_LICENSING_IPV6=<1/on>

Description: This variable enables support for the IPv6 protocol in the Licensing modules. When set,
and if the machine supports an IPv6 socket stack, communication will utilize IPv6. If the machine does
not support IPv6, communications defaults to IPv4.

Default value/range: Default=0) Range=0-1

Corresponding command argument: N/A

Hardware platform restrictions: IPv6 support

Example: This example specifies that licensing modules should communicate using IPv6 protocol:

ANSYS_LICENSING_I1PV6=1
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Chapter 3: HPC Licensing

Ansys, Inc. offers multiple high performance computing license options, described below.

When using FlexNet Publisher (FNP) based licenses, the HPC license options cannot be combined with
each other in a single solution; for example, you cannot use both Ansys HPC and Ansys HPC Packs in
the same analysis solution. However, Ansys HPC OR Ansys HPC Packs can be combined with Ansys
Elastic Licenses (AEC) in the same analysis solution. Note that Elastic Licensing does not support Ansys
HPC Packs, therefore, any Ansys HPC type request from an application is converted into Ansys HPC
when using Elastic Licensing.

See the applicable product documentation for instructions on configuring and running a distributed
solution.

3.1.Ansys HPC

These physics-neutral licenses can be used to run a simulation across multiple cores and/or GPUs and
work with most Ansys applications. Some Ansys applications can utilize CPU processors and/or GPUs.
We will use the following definitions to describe licensing behavior on GPUs:

+ Native GPU Solver: a solver that operates on GPUs to calculate the solution.

« Offload GPU Solver: a solver that operates on CPUs but offloads some part of the solution to GPUs
to accelerate the solution.

* GCU (Graphics Compute Unit): a processing unit in a GPU card. In NVIDIA GPU cards these are called
Streaming Multiprocessors (SMs), while in AMD GPU cards they are named Compute Units (CUs). Each
GPU card contains many GCUs, with the number varying depending on the GPU model. While GCUs
are architecturally different to cores on CPU, we can make the analogy to CPU cores from a licensing
perspective.

Solvers running on CPUs license on a per core basis, while solvers using GPUs may be license per GPU
card or per GCU.

Most Ansys applications allow you to use four CPU cores without using any HPC licenses, while the
number of GPU cards or GCUs included in the solvers varies (see table below). Ansys HPC licenses add
to this base solver functionality, enabling more CPU cores, GPU cards, or GCUs. For example, running
Ansys CFD Enterprise using twelve CPU cores will consume only eight Ansys HPC licenses, since 4 cores
are included in the solver. Contact your Ansys sales representative for a complete list of applications
with this option.

Note:

HPC licenses and HPC Pack licenses cannot be combined within the same solution. Addition-
ally, HPC licenses do not participate in license borrowing.

Release 2026 RT-© ANSYS, Inc.Allrights reserved.- Contains proprietary and confidential information
of Synopsys, Inc., ANSYS, Inc., subsidiaries and affiliates. 37



HPC Licensing

3.1.1. Ansys HPC Pack Licenses

Ansys HPC Pack Licenses can be used to run a simulation across multiple cores/GCUs and work with
most Ansys applications. Contact your Ansys sales representative for a complete list of applications
that can be used with Ansys HPC Pack Licenses. Individual HPC Pack Licenses cannot be split between
multiple users or between multiple analyses.

Products with Included Cores

(RadCAD)

Application/Module Included |Included GPUs |Native GPU Solver: Offload GPU
CPU or GCUs HPC tasks per Solver: HPC tasks
Cores additional GCU or per GCU or GPU

GPU

Additive Suite 4 N/A N/A N/A

Ansys Rocky 4 112 GCUs 1 per GCU ( 2) N/A

Agwa 4 N/A N/A N/A

Autodyn 4 N/A N/A N/A

CFX 4 N/A N/A N/A

Chemkin 4 N/A N/A N/A

Circuit 4 N/A 8 per GPU N/A

Discovery 4 1 GPU See 5 See 5

EMIT 4 N/A 8 per GPU N/A

Explicit 4 N/A N/A N/A

FENSAP 4 N/A N/A N/A

Fluent 4 40 GCUs 1 per GCU N/A

Forte 4 N/A N/A N/A

FreeFlow 4 75 GCUs 1 per GCU N/A

HFSS 4 0 8 per GPU 8 per GPU

Icepak 4 0 8 per GPU N/A

LS-DYNA 1(1) N/A N/A N/A

Lumerical 4 4 GCUs 1 per GCU N/A

Maxwell 4 0 N/A 8 per GPU

Mechanical APDL 4 N/A N/A 1 per GPU (4)

Motion 1 N/A N/A N/A

Polyflow Classic 4 0 N/A 1 per GPU (4)

Q3D 4 N/A N/A N/A

RBD 4 N/A N/A N/A

Slwave 4 N/A N/A N/A

Speos 4 16 GCUs 1 per 4 GCUs N/A

Thermal Desktop 16 N/A N/A N/A
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Ansys HPC

1. Ansys LS-DYNA HPC needed

2. Requires Ansys Rocky HPC

3. Requires Ansys OPTIS HPC

4, A maximum of 50% of the HPC tasks can be used to enable GPUs, for example 2 HPC Packs enables

a total of 36 cores and a maximum of 18 can be used for GPUs.

5. Discovery offers GPU-based solvers, with 1 GPU card included. You cannot use multiple GPU cards.
CPU solves are supported only in the Refine stage and follow standard HPC task consumption
rates for cores requested.

HPC Packs per Simulation

A

Parallel Cores

32768+4
s102+a 52772
96
2048+4
2052
512+4
516
128+4
132
32+4
36
8+4
12
>
1 2 3 4 5 6 7

You may only borrow one Ansys HPC Pack license at a time.

3.1.2. HPC License Sharing (System Coupling)

When running a system coupling calculation using multiple solvers. Each solver has to check out its
own HPC licenses. For example: A system coupling calculation where Fluent is using six cores and

Mechanical eight cores would require the simultaneous checkout of the following licenses.

Fluent: Requires the base CFD solver enabling the license plus either a HPC Pack, or 2 additional
Ansys HPC licenses
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HPC Licensing

Mechanical: Requires the base mechanical solver enabling the license plus either a HPC Pack, or 4
additional Ansys HPC licenses

3.1.3.HPC Licensing with Hyperthread Cores

For Ansys HPC licensing, a hyperthread core is treated as being the same as a physical CPU core. If
you run a 24 core Ansys solution on a CPU with 12 physical and 12 hyperthread, you will consume
the number of HPC licenses required to enable a total of 24 cores. Typically, the 12 Hyperthread cores
will enable little or no speedup to the calculations and therefore hyperthreading is not recommended.

3.2.Shared HPC Licensing for Concurrent Parametric Variations

Starting with Ansys release 2020 R2, HPC licenses may be used for concurrent simulation of parametric
variations, allowing you to leverage standard HPC licenses instead of extra solver licenses. Each variation,
after the first, requires 8 HPC increments or 1 HPC Pack increment. Similar to non-parametric simulations,
each variation provides 4 included parallel cores or GPU SMs per variation. Additional HPC parallel cores
are shared across all variations, using the same HPC rules. All licenses that are consumed during a
concurrent parametric simulation are held for the duration of the simulation, based on the max count

of each license required for a given variation.

You can use the Ansys Parametric Licensing Calculator (https://ansys.com/parametric) to determine the
number of HPC Workgroup or HPC Pack licenses required.

When Upfront License Checkout option, is enabled in Ansys Workbench (see Using Upfront License
Checkouts for Design Point Updates), a different algorithm is used to calculate the number of HPC In-
crements that should be checked out upfront of the parametric update.

In the case where upfront license checkout is enabled, the number of HPC increments checked out at
start of parametric update=(k*(max(0,((i%j) -4)))) + ((k -1)*8).

i=number of solver and preppost enabling licenses pre-selected
j=number of cores required per simultaneous task

k=number of simultaneous tasks requested

HPC Parametric Example

6 Parametric Variations, 24 Cores/Variation
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https://ansys.com/parametric

HPC Licensing Frequently Asked Questions

Example: Position slot at various distances from HPC Workgroup

right end of tee. Solver 1 Solve

Parallel 6 variations x 24 cores
},\ 120 HP

: d 4 Included Cores | - 6 variations x 4 cores
\{ Parametric 6 variations 40 HP(
' 1 Solve
TOTAL 160 HP

Variation d HPC Pack

1 2cm Solver 1 Solve

2 3cm Parallel 6 variations x 24 cores
3 4cm — 3 HPC P

4 Included Cores | - 6 variations x 4 cores
4 5cm Parametric 6 variations 5 HPC Pe
5 6cm TOTAL 1 Solve
6 7 cm 8 HPC Pz

3.3.HPC Licensing Frequently Asked Questions

This section lists common questions you may have while setting up licensing.

Which files contain the HPC license preferences?

HPC license preferences determine whether an HPC Pack or individual HPC licenses are used first. The
preferences are stored in a .xml file.

Linux:

~/ .ansys/v261/licensing/license.preferences.xml

Windows:

Y%appdata¥%\Ansys\v261\licensing\license.preferences.xml

To set the HPC Licenses preferences, see Setting HPC User Preferences (p. 26).

Why do multiple core Ansys LS-DYNA calculations fail when | appear to have
HPC Pack or Ansys HPC licenses available?

Standard Ansys HPC licenses such as anshpc and anshpc_pack, cannot be used with Ansys LS-DYNA.
Ansys LS-DYNA uses Ansys LS-DYNA, dysmp, licenses to enable multiple core calculations.
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How many HPC license are used when I run Ansys LS-DYNA on multiple cores?

When run on multiple cores, Ansys LS-DYNA will consume dysmp licenses. These licenses are available
for purchase in different quantities, as Ansys LS-DYNA HPC, Ansys LS-DYNA HPC-8, 16, 32,64,128 and
256.The licenses can then be added together, to enable the total number of cores requested by a cal-
culation. A calculation run on <n> cores, will consume a base Ansys LS-DYNA license (dyna), plus <n-
1> Ansys LS-DYNA HPC licenses (dysmp).

Does the number of CUDA cores on a GPU card change the number of HPC li-
censes used?

The number of HPC license consumed when using GPU cards to accelerate an Ansys solution depends
on the number of GPU cards used and the number of separate GPU engines on each card. The number
of HPC licenses consumed, does not depend on the number of CUDA cores, supplied by each separate
GPU engine.

Is there any disadvantage to not renewing TECS on my perpetual HPC license?

If you do not renew TECS on perpetual HPC licenses, the HPC licenses can only be used to enable
multiple core calculations for Ansys solvers that were released before the date of expiry, of the TECS.
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Chapter 4: Troubleshooting

This section contains information that may be useful when working with Ansys customer support.

4.1.Getting Additional License Debug Information

Use the following suggestions to display or generate additional error messages and debugging inform-
ation.

+ View the licdebug file. The Iicdebug file is generated when you run an Ansys, Inc. application
and resides in the .ansys subdirectory under the directory specified by the TEMP environment
variable (Windows) or in the SHOME directory (Linux). The Iicdebug filename will vary depending
on the product but will follow the format 1 1cdebug.<pr oduct >.261.out. For example:

If a Iicdebug file already exists and is dated today, the information is appended. If it is dated before
today, the existing file will be renamed with a .old extension and a new file will be started.

Mechanical APDL (Ansys): licdebug.ANS_SOLVER.261.out
Ansys Workbench: 1 icdebug.ANS_WB.261.out

Mechanical: 1 icdebug.MECH.261.out

Ansys Fluent: Iicdebug.FLUENT_SOLVER.261.out

Ansys Polyflow Classic: 1 icdebug.POLYFLOW.261.0out
Ansys CFX-Pre: I1cdebug.CFX_PRE.261.out

Ansys CFX Solver: Iicdebug.CFX_SOLVER.261.out

Ansys CFD-Post: licdebug.CFD_POST.261.out.

Ansys ICEM CFD (includes Al*Environment): 1 icdebug. ICEM_AM.261.out
Ansys Icepak: Iicdebug. ICE_PAK.261.out

Ansys LS-DYNA: Iicdebug.DYNA_SOLVER.261.out

Connection functionality: I icdebug.ANS_PM.261.out

Note:

The license debug file names include the current release of the application. Because not
all applications are updated with each release, it is possible to have lic\debug file names
that are appended with older release numbers. For example, it is possible to be running
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Ansys Release 16.1 but still have a product license debug log file name include 160 as in
licedbug.POLYFLOW.160.0ut.

The directory specified by the TEMP environment variable may be hidden on your system. To view
the directory and file, click My Computer. Choose Tools from the menu, and then click Folder options.
Click the View tab and select Show hidden files and folders. Click OK.

If after following these suggestions, the resulting debug information does not make sense, try these
suggestions:

Confirm that the license manager was restarted or the license file was reread after any changes
were made to the license file. If you did not make any changes to the license file for the server,
check the date/time that it was last changed. Get the relevant path information from the debug
output. Also, confirm that the same path is being used.

Try restarting the license manager and then attempt to run again. See if the same situation occurs.

If you installed a new license file but are not seeing it even after restarting the license manager,
confirm that the correct license file is being used to start the license manager. In this case, neither
the client application nor the license manager is using the changed file. Also confirm that if site
or user license preferences were set, the preferences were updated with the new license inform-
ation.

If the ansysImd. lic file is at the end of the path and it is a license file that uses the license
manager daemon/service, then confirm that the license manager is started with the same path
as the ansysImd. Lic file's path. The license manager could be looking at one file in the client
application but the license manager daemon/service was started with another file.

4.2, Application Fails to Start

This section contains information that may be useful when addressing licensing issues on the Linux
platforms.

4.2.1. Application fails when initializing licensing on Linux Platform

When running Ansys applications on server versions of Red Hat 7x and CentOS 7x, Security-Enhanced
Linux (SELinux) can block ansyscl communications.

To correct this issue, make sure to establish rules within SELinux to allow Ansys applications (ansyscl)
to communicate with ansysimd.

4.2.2. Mechanical application fails to start

A new preference is now available in Mechanical Workbench: Close Mechanical During Launch If
No License in the Tools > Options dialog, under the Mechanical category. If selected, this preference
terminates opening the application and displays a message if no license is available in the queue or
if the license checkout process fails. Selecting this preference can save time since otherwise the ap-
plication opens in read-only mode, which can be a lengthy process for large projects. You can obtain
license failure information in the licensing debug file.
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